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1.  Въведение в ClassPad 
 

ClassPad е естествена, усъвършенствана форма на график калкулатор. Върви 
заедно със впечатляваща колекция от приложения и самообучаващи се 
апликации като 3D Graph, Geometry, eActivity, SpreadSheet и още много други. 

Уредът позволява добавяне на текст, както на английски, така и на 
български, и го визуализира по начиа, по който той е представен в учебника. 
Авторизацията на текстове, изчертаване на графики, изчислителни и други 
операции могат да бъдат представени бързо и автентично на голям LCD екран. 
ClassPad калкулаторът предлага множество графични инструменти, необходими 
за изчертаването на 3D графики и геометрични обекти, които създават една 
изключително благоприятна среда за обучение и само обучение на студенти. 

Интерфейса на калкулатора използва pull-down menu формат, което 
опростява дори сложни на пръв поглед операции. Множество изречения, изрази 
и други теми могат да бъдат избрани с едно натискане на стилуса. ClassPad 
поддържа ‘drag and drop, ‘copy and paste’ операции, както и други, които 
свеждат до минимум използването на каквито и да било други ключови 
операции. 

Приложенията за презентации, както и инструментите за създаване на 
материали за лекции и решаване на голям набор от задачи, позволяват на 
преподаватели да представят тезите си по начин разбираем за студентите, както 
и осигурява една добра база за схващане на математически понятия и проблеми, 
в процеса на решаването им. Отделна операция може да бъде заснета и по- 
късно добавена към презентация и пусната в slideshow формат.  

Приложението eActivity позволява работа с изрази, формули, фигури и 
различни графики, като позволява на студенти да се учат и напредват сами, 
използвайки техни лични методи за решаване на задачи, изхождайки от добре 
познати алгоритми за решаването им. Това е кръстосан (само)обучаващ 
инструмент, който спомага за изследване, различни манипулации и споделяне 
на математически решения. ClassPad позволява цялостното разбиране на 
проблема, като помага на студентите да открият и развият техните собствени 
възможности. 

Калкулаторът може лесно и удобно да се свърже към компютър за 
прехвърляне на информация, като е и възможен и осъществяване на трансфер на 
снимки. Използва се ClassPad Мanager в CD-ROM, които върви с калкулатора и 
допълнителен кабел. Може да се осъществява трансфер на програми и 
материали (e-Activities) от вашия ClassPad към компютър или от ClassPad към 
ClassPad използвайки  ClassPad Manager. 

ClassPad не е само график калкулатор, а следващо поколение калкулатор, с 
научно изследователска и образователна цел. С  ClassPad студентите могат да 
манипулират сложни математически изрази, превеждайки ги до по- прости и 
разбираеми уравнения, позволявайки лесното схващане на връзки между 
различни математически области ( вектор и геометрия). Предлага  един нов 
поглед върху математиката, довеждайки я до  различни, лесни за разбиране 
примери. 

ClassPad е различен от останалите общоизвестни калкулатори защото той 
предлага: 

-   въвеждането на информация с едно докосване със стилуса ; 
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-   осигурява въвеждане/ извеждане на естествени математически изрази  
 (програмен режим е включен); 

- изчисляването с ClassPad е лесно и бързо като се използват дроби, 
лимеси,диференциали, интеграли, матрици и още много други вградени 
функции ; 

-   извеждане на резултат в естественият му математически вид; 
-   четири нови приложения  включени, като добавка към калкулатора: 

eActivity, Geometry, Presentations и 3D Dimensional graphic. 
 
1.1  eActivity application 
 

eActivity и Presentation application спомагат за лесната манипулация, 
експлоатация/изследване и споделяне на намерени решения пред голяма  
аудитория. Това помага на студентите да увеличат заинтересоваността и 
подобрят своите лични възможности в областта да математиката.   

eActivity има четири основни преимущества пред използването на лист и 
химикал; 

- използвайки това приложение се създава благоприятна среда на лични 
разработки, както и материали за лекции и презентации ; 

- осигурява  на студентите  работа върху задачи по свой темп и 
възможности ; 

- позволява откриване на различни начини за решаване на задачи; 
- дава възможност на текст, изрази, фигури и графики да се визуализират 

на екрана на ClassPad 330. 
  

Какво е eActivity?- това е нов, електронно-образувателен инструмент, които 
може свободно да бъде  изучаван в ClassPad. С помощта на това приложение 
могат да се ползват всички полезни функции вградени в ClassPad 330. Той е 
едновременно и учебник и учебна тетрадка. Преподавателите могат да го 
използват  за създаване на електронни примери и упражнения, да разрешават 
проблеми с помощта на текст, математически изрази, 2D  и 3D графики, 
геометрични чертежи и таблици. eActivity осигурява на студентите среда за 
изследване и разработки, като им позволява запаметяване на получени 
резултати, комбинирани със забележки от тяхна страна. 
 eActivity application осигурява въвеждане на текст и математически 
изрази както и ClassPad приложна информация, като запаметява файла като 
‘eActivity’. Стандартният еActivity файл съдържа текст,информация, която e 
поставена в лента или ред. Като редът може да бъде във вид на ‘Row text ’, 
‘Geometric row’ или ‘Calculation row’. Като ивица/ лента се представя под 
формата на т.нар. ‘Application data strip ’(main, geometry, graph , conics sequence 
и т.н.) 
 
Създаване на eActivity 
 

Натискаме ‘Menu’ за да се визуализира ‘Application menu’, от където 
избираме иконата за eActivity. Визуализира се прозорецът на eActivity, такъв 
какъвто е бил последният път когато е бил използван. При избор на file/new ще 
се отвори нов прозорец, а информацията от старият ще бъде изтрита. Има 
четири вида информация, която може да се включи в eActivity прозореца- текст, 
изчислителен израз, геометричен обект или приложна информация за 
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визуализиране. След като eActivity е по начина, по които желаем може да бъде 
запаметен от file/ save. Визуализира се file-диалогова кутия, След избор на папка 
и име на файла ( максимум 20 символа) се натиска save. Запаметените 
файловете са сортирани в област от паметта, която е разделена от паметта за 
останалите типове информация. Поради това от Managing eActivity file не може 
да се осъществи достъп до Variable Managing или Managing Geometry 
Application file. 

 
Text row се използва за добавяне на текст и математически изрази в 

нормалният им вид, като текста може да се удебели. Calculation row се използва 
за да се въвеждат изчислителни операции, които са валидни в Main 
приложението. The application data strip визуализира прозорец от някое ClassPad 
приложение (Main, Graph and Table, Geometry) и използва прозореца за да 
създаде информация, която да бъде по- късно включена в eActivity, Geometry 
link row е направена за да осъществи връзка с геометрични фигури. Всички те се 
добавят от менюто Insert. 

 
  

             
 
 
 Text row добавя текст както и математически изрази, но които не е 
изпълним при избиране на бутона Еxecute. Всички команди в Тext row се 
третират като текст. Когато текстът, които се въвежда е прекалено дълъг, 
курсорът автоматично се прехвърля на следващият ред. При въвеждаме 
математически изрази, курсорът остава на същия ред, дори ако изразът е 
прекалено дълъг. Появяват се стрелки, които индикират, че има информация на 
ляво или на дясно от него. 
 

Calculation row  позволява  изпълнението на всякакъв вид изчисления на 
eActivity приложението. Когато се въведе математическия израз, резултата се 
появява подравнен отдясно на екрана. Винаги може да се редактира въведената 
информация, но никога резултатът. В случай на грешно въведен израз, резултат 
няма да се появи.  
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Ако  се изисква резултатът да не се визуализира не трябва да се натиска 

Еxe бутона от вградената в ClassPad клавиатура. При промяна на входните 
данни, изходните автоматично се променят. Дори математически изрази, които 
по принцип са вкарани в eActivity без пресмятане, са пресметнати и техният 
резултат се появява на екрана. 

 
 Application data strip може да бъде използвана ако се изисква да  се 
добавя информация от някакво друго приложение към eActivity. Този елемент 
съдържа поле, в което може да се окаже заглавие, информация и бутон, които 
при натискането му ни отвежда към желаното приложение. Често екрана е 
разделен да две половини. Активна е тази половина, която е избрана. 
Добавянето на Application data става от  Insert менюто и се избира  Strip. От 
Дясно на екрана се появява падащо меню с опции за избор, които  дават достъп 
до ClassPad приложения като Графика- 2D, 3D, графика на диференциални 
уравнения , таблици и геометрични обекти, както и много други. 
 
 За да се добави Geometry data се избира Insert → Strip → Geometry. 
Появява се прозорец подобен на предишните- поле, в което може да се окаже 
заглавие на проекта или разработката и бутон, при натискането на който екрана 
се разделя на две и се визуализира геометричния обект  които е избран от 
лентата с инструменти 
 
 

 
 
 
 По същият начин се добавят и графики. Основното тук е, че трябва да се 
окажат уравненията, необходими за изчертаване на графики. На чертежа може 
да има повече от една графика, като изчертаването на всяка да става с различна 
дебелина на линията. 
 
 

Този бутон  показва , че сме в режим  
Calculation   input mode 

Отметката се визуализира в началото на реда, 
когато calculation mode е селектиран 
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 Добавяне на функции става от бутона 9, като могат да се добавят 
максимум 100 функции. 
 

Може да се използва полето Notes за добавяне на всякакъв вид 
информация. Notes е текстово поле за редактиране и стилизиране на бележки 
или добавяне на пояснения в сложни математически изрази в eActivity.  

 
При избор на Insert → Strip →  Notes се отваря прозорец в долната 

половина на екрана. От лентата с инструменти въведеният текст може да бъде 
коригирам по начин, по които желаем. Това приложение е активно само в 
eActivity. 

 
eActivity позволява и визуализирането на картинка (bitmap image). 

Добавянето S се озъществява от Insert → Strip → Picture, при което в долната 
половина на екрана се отваря прозорец за добавяне на изображение. При избор 
на File → Open се отваря меню за избор на файл, но основното е, че трябва да е 
от тип PICT. 

 
eActivity е едновременно и тетрадка и учебник, позволявайки  да се 

изследва света на математиката. Почти всеки израз от eActivity  може да бъде 
включен в някое от другите приложения, както и да бъде взета информация от 
външно приложение и да бъде включена в eActivity. 

 
С добавянето на Geometry link row автоматично се добавя информация в 

Geometry прозореца, като се осъществява връзка с информацията от  eActivity. 
Може да се визуализират линии и фигури като стойности или математически 
изрази в Geometry link row. Влаченето на линия или геометрична фигура от 
Geometry window до  Geometry link row ги превръща автоматично в техния 
еквивалентен математически израз. Този израз е свързан с Geometry window, 
което прави промяната на което и да е било условие валиднa и за 
визуализираната фигура в долната част на екрана. Промяната на израз в 
Geometry link автоматически променя фигурата в Geometry window. 
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Възможен е трансфер на eActivity файл тъм друг ClassPad Unit, но е 
нужно приемащата файла част да  поддържа всички типове от  Application data 
strip (Graph, Graph Editor, 3D Graph, 3D Graph Editor, Conics Graph, Conics  
Editor, Geometry, SpreadSheet, Stat Graph, Stat Editor, DiffEqGraph, DiffEqGraph 
Editor, Financial, Probability, NumSolve, Sequence Editor, Picture Viewer, Note, 
Main, Verify). Ако прехвърляме информация към друг ClassPad, които не 
поддържа някои от тези приложения, получателят няма да може да отвори 
файла.  

 
Възможен е и трансфер между ClassPad и компютърът. За целта може да 

се използва FA-CP1. Желателно е първо да се провери версията на  FA-CP1, 
зареден на компютъра с операционната система на ClassPad, за да се установи 
дали са съвместими. Друг начин за осъществяване на трансфер, които е и много 
по- удобен, е чрез използване на Exchange window върху ClassPad Manager( 
появява се при натискане на десен бутон на мишката). При което се отваря 
диалогов прозорец ClassPad Manager- Exchange. Когато ClassPad е включен към 
компютъра от ляво на екрана стават видими файловете от компютър и ClassPad. 
Трансфера се осъществява при влачене и пускане на избрания файл. 

 
   eActivity е полезен и в класната стая, и в къщи. Студентите могат сами 
лесно да променят математически изрази или числови стойности и да  решават 
проблеми, които те сами си възлагат. На базата на получени  резултати, се 
изготвят презентации. За удобство се използва Presentation application и RM-
ClassPad. Функциите за презентация осигуряват запас от информация, която се 
визуализира на LCD екран като картинка или под формата на слайдове. Това е 
много ефективен начин за представяне на резултатите от групово проучване или 
мащабно проект. Презентацията може да бъде и по- ефективна ако е допълнена 
от RM-ClassPad за прожектиране чрез OHP. То  позволява да се изпраща дата от 
калкулатора към екран или стена. 

• С drag/drop 
функцията се 
изчертават 
бързо 
геометрични 
фигури; 

• При промяна на 
параметрите 
лесно и 
ефективно се 
променят 
размерите на 
б
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 Интересното при ClassPad и на което трябва да се обърне внимание, е 
организацията на файловете. Системата е разделена на две директории- такава, 
която е извън eActivity, Main и всички останали и друга, която е включена в 
eActivity, Main и т.н. Двете директории нямат връзка помежду си и файлове от 
едната не могат да бъдат четени или обработвани от/ в другата. Но все пак 
връзка може да се осъществи и това става възможно с помощната директория 
library, която служи за връзка между останалите две.  
 
1.2  Presentation application 
 

Presentation application позволява да се направят снимка от други 
Windows приложения, организирайки си във вид на презентация. С 
приложението може да се реализира и коригира съдържанието при 
необходимост. Презентация, например, може да покаже как са получили 
междинни и крайни резултати стъпка по стъпка. Те могат да бъдат използвани в 
класната стая и/или друг вид представяне като се свърже ClassPad с OHP-
прожектора. По този начин учители могат да представят своите разработки пред 
голяма аудитория, правейки задачите разбираеми и достъпни за останалите. 
Студентите, от друга стана, използвайки приложението, могат  елегантно да 
представят своите задачи, реферати и проекти.  

 
Приложението се стартира от иконата за Presentation application в 

главното меню. Отваря се следният диалогов прозорец: 
 

 
 

OH-ClassPad ви 
позволява да 
изпращате 
информация от 
управляващо 
средство към OHP 
прожектор за 
презентации на 
OHP- екран! 

• При избиране на  полето disabled би довело 
до автоматичната промяна на [Screen copy to] 
настройките на презентацията и 
Communication dialogue boxes към [Outer 
device]; 

• Файловете са номерирани от Р1 до Р20. Тези 
номера са фиксирани и не могат да бъдат 
променяни; 

• Когато е създаден нов презентационен файл 
може да му се окаже име; 

• Срещу името на всеки файл се вижда и 
неговият размер в страници;
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 След като  приложението е стартирано, от файл- листата се избира 
първият ред ( от Р1 до Р20). Курсорът се появява на избрания от нас ред, което  
позволява да се въвежда 8 байтово име на файла. Когато е готов се  натиска 
(EXE). Трябва да се уверим, че името, което току що е въведено е избраното. 
При всеки избор на Print screen, автоматично се добавя изображение в избраната 
от нас презентация. Едва когато disable е маркиран процеса се прекратява. 
Презентацията се стартира от един от посочените бутони: 67. Като при 
избор се отваря диалогов прозорец, който  дава възможност да се избере 
желаната  презентация. При избор на първия бутон презентацията се стартира и 
свършва едва когато всички слайдове се изредят. При избор на вторият бутон се 
контролира от нас. 
 
 

           
 
 
 
1.3  Geometry application 

 
Geometry application  позволява да се изчертават и анализират геометрични 
фигури. Може да се изчертават триъгълник и да се определи точно отношението 
на страните му в отношение, например 3:4:5, и да се провери големината на 
ъглите при всяка промяна. Може да се изчертават окръжност и след това права, 
която е тангенциална на определена точка от окръжността. Това приложение 
включва още и опция за анимиране на фигури, което позволява да се 
наблюдават как те се променят, при всяка въведена промяна. 
 
 Приложението се стартира при избор на иконата G. Draw менюто  
осигурява изчертаване на точки, полигони, прави, елипси, окръжности и други 
геометрични фигури. 
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 Draw менюто съдържа и събменю. То може да бъде използвано за 
добавяне на среда на отсечка, изчертаване на перпендикуляр по зададена друга 
точка или друга геометрична фигура, както и тестване на геометрични теореми. 
 
 
 

               
 
 
 При натискане на стрелката от дясно u се визуализира. Measurement 
box, където могат да се видят или променят избрани от нас размери. От лентата 
с инструменти се избира фигурата, която искаме на начертаем. 
 

Приложението  дава и възможност 
да изчертавате и функции. Веднъж 
изчертана, фигурата може, при 
желание, да бъде местена или 
редактирана. 
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 Както вече беше споменато, Geometry application дава възможност за 
изчертаване на функции. Това става при избор на бутона Function от лентата с 
инструменти, при което се отваря диалогов прозорец, които  дава възможност да  
se избере типа на функцията (Polar, Parametric или f(x)) и прозорец, в които се 
оказва желаната функция. 
 
 
 

                 
 
 
 При избор на Polar на екрана се визуализира Soft keyboard, a в 
диалоговият прозорец се оказва радиусът. В примера по- долу е показано 
уравнението r=θ. 
 

Точка 
Безкрайна линия 

Вектор 
Арка 

Елипса 
Парабола 
Полигон 

Отсечка 
Лъч 
Окръжност 
Елипса 
Хипербола 
Функция 
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 При избор на Parametric се оказват две функции, като се дава 
ограничения tmin и tmax. След изчертаването на фигурата може да се включи в 
Main или eActivity. Уравнението се появява като текст с графика, която се 
визуализира по- долу. 
 
 Дава се възможност да се добави и текст докато работим с Geometry 
application. Това става от менюто Draw→Text  при което се отваря диалогов 
прозорец за въвеждане на текст. Приложението дава възможност за въвеждане 
както на текст, така и на математически изрази. 
 
 

               
 
 
  Лесно и бързо може да се направят измервания на ъгли, както и 
коригирането им. В примера показан по- долу е измерен един от ъглите в 
триъгълник. За целта страните се маркират и от Draw избираме Attachment 
angle. 
 

Функция от 
Geometry 
application може 
да бъде 
включена в 
Main или 
eActivity 
приложението. 
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  Интересно е да се отбележи, че двете страни на фигура, формират не 
един, а четири ъгъла. За да се измери които е от тях е нужно само да се 
използвам функцията drag/drop и да се постави маркерът там където искаме да 
измерваме. 
 

             
 
  Може да се използват Expression командата и командите от подменюто 
Measurement за да се изпълнят редица изчисления, използвайки големина на 
ъгли, дължина на страни, лице на област или други мерни стойности оказани 
към фигура и резултати визуализирани на работният прозорец на Geometry 
application. 
 
Пример:  дадени са отсечките  AB и CD, като точка C принадлежи на правата 
AB. Да се намери сумата от ъглите ACD и BCD. Да се визуализира резултата на 
екрана. 

- изчертават се двете линии; 
- маркират се и от менюто се избита attachment angle, което автоматически 

ще доведе до изображението на големината на ъгъл ACD; 
- маркира се и се влачи (мести) в другият ъгъл; 
- маркират се отново двете линии и се избира отново attachment angle. По 

този начин се визуализират едновременно и двата ъгъла. 
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- От Draw се избирам Expression. В Measurement window въвеждаме 
формулата която EXPR=@1+@2. По този начин, двата елемента 1) и 2) 
ще бъдат избрани и резултатът ще се запише е 3).  

 

           
 
 
 
Построения в Geometry application 
 
 Construct подменюто на менюто Draw подпомага изучаването на 
геометрични теореми. Като добавка, към под менюто са включени  
ъглополовяща, перпендикуляр, средна точка, сечение, паралелни линии, 
тангента на крива, а също така и ротация, транслация, трансформация на фигури 
и рефлексни точки. 
 
За целта преди да се избере каквато и да е операция за построения трябва първо 
да се изчертаят основните обекти върху, които ще се проектира. Едва тогава от 
Draw  се избира Construct и една от опциите, които искаме- Perpendicular 
Bisector, Perpendicular, Midpoint, Intersection, Angle bisector, Parallel, Tangent to 
curve, Reflection, Translation, Dilation или General transform. При построение на 
сечение на две прави, общата точка не може да бъде местена. Принципът за 
намиране на обща точка между права и окръжност или две окръжности е 
аналогичен с сечение на две прави. 
 
 

- При транслирането (преместването ) на линия по зададени стойности на 
вектор довежда до появата на нова линия, която е съгласувана с 
изходната, успоредна и съобразно зададените стойности на вектора. 
Възможно е и преместване на линия като се избере зададен вектор. За 
целта трябва да се начертае допълнително вектор. При отваряне на 
диалоговият прозорец се селектира. 
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- за изчертаване на огледален образ на 
елемент се избира опцията Reflection. За 
целта се изчертава линията- образец, и 
друга, която да служи за ос на симетрия. 
След това се маркира основната линия и  се 
избира Reflection от Draw менюто. Това 
автоматически прави активен бутона за 
Reflection в лентата с инструменти. Избира 
се оста на симетрия и новата линия се 
визуализира на екрана 

- За ротация на линия се използва опцията Rotate. 
Изчертава се линията и след маркирането и се 
избира Rotate. Трябва да се окаже точка, която ще 
се счита за център на ротацията. Появява се 
диалогов прозорец в които се посочва ъгълът на 
ротация. Когато сме готови се натиска ОК. 
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 General Translation, използвайки матрици или вектори позволява, при 
въвеждането им да се променят фигури.  Резултата от промяната е нова фигура, 
която се появява на екрана. Чрез Geometry application може да се изчертават 
симетрични една на друга фигури, като се оказва спрямо  абсцисата или 
ординатата да са симетрични. 
 
 Когато изходната фигура е начертана се избират всичките и страни. От  
Draw → Construction →  General Transform се отваря диалогова кутия, разделена 
на две. За да се получи, така че новата фигура да е симетрична спрямо                
х- абсцисата на изходната фигура се въвежда в първият прозорец [1,0][0,-1]. 
 
 При желание може да се направи паралелно преместване с една единица 
по Х и У. За тази цел се пише [1,1] във вторият прозорец, така както е показано 
в примера по- долу. 
 

 

                     
 
 

 По-лесно е да се разбере как General Translation работи ако се използва 
заедно с eActivity или Main приложението, комбинирано с Geometry application. 
Това прави възможно изпълнението на следните трансформации: 
 

-    В Geometry application може да се избере точка от фигурата, получена след 
трансформацията, и точка от изходната фигура. Влачейки ги в Main 
приложението, се визуализира на екрана изразът, довел до 
трансформацията; 

-    Може да се избере триъгълник, влачейки го в Main, да се  превърне 
например от триъгълник в матрица с два реда и три стълба, която 
изобразява три координати. Валидна е и обратната операция. 
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Geometry application и анимация 
  
 Анимацията съдържа една или повече точки/ криви като кривите могат 
да бъдат линия, сегмент, окръжност, елипса или функция. Анимацията се 
построява при избор на точка/ крива и добавяне към Animation. Може да 
стане по два начина. Единият е като се избере Edit → Animate,а другият е 
когато се избере от лентата с инструменти View →  Animation UI 
 
 Изчертава се първо точката и кривата, по която тя ще се движи. След 
това се маркират и от основното меню се избира Edit → Animate → Add 
animation, при което избраната от нас точка автоматично се премества върху 
кривата. При следващо избиране на Edit → Animate →  Go (once)/Go (repeat)/ 
Go (to and fro) се оказва как да се движи тя. При избор на Stop анимацията се 
спира. 
 

Важно е да се 
отбележи, че тази 
операция е възможна 
само ако на точки, 
които се избират са 
от основната фигура 
и кореспондентната 
такава. Нищо няма 
да се появи при 
избор на две точки 
от новата фигура 
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Работа с файлове в Geometry application 
 

 
 
 

В случай, че се изисква да се променят някаква 
зададена от нас анимация се избира Edit → Animate 
→ Edit Animation.  Появява се следният диалогов 
прозорец. 
В него може да се окаже каква да е стъпката на 
движение. Тези настройки показват стъпки, които 
точка D ще направи при анимирането и по AB. Под 
менюто Animations се появяват всички точки, които 
се анимират. В нашият случай е точка D. ако се 
избере Remove се премахва приложната точка. ‘t0’ и 
‘t1’ индикират  кривата AB. Ако например се 
променят настройките на  t0 от 0 към 0.5 това ще 
доведе до промяна на стартовата позиция и 
анимираната точка ще започне своето движение от 
средата на кривата AB

При избор на филе File → Save  се отваря 
следната диалогова кутия  
 
Избира се директория където искате да се 
запамети, като се оказва име, което трябва да е с 
големина 8 байта. 
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1.4   3D Dimensional Graph application 
 

Това приложение ви позволява да чертаете 3D графики от вида на z=f(x,y) и 
параметрични уравнения. То се стартира от иконата за 3D графика D, при 
което на екрана се отваря 3D граф редактора и 3D граф прозореца. Функциите, 
които са нанесени в 3D граф редактора се изобразяват в 3D граф прозореца. 
 

 

 
 
 

 
Най- отдолу се вижда статус бара. Real индикира, че режима е Real mode (real 
number calculation). Другият режим, които ClassPad ви позволява да изберете е 
работа с комплексни числа Cplx (Complex number calculation). Rad показва, че 
работим в радиани. Другите опции са Gra и Deg. 

Запаметяване на 
файл под друго име 

Търсене на 
файл 

Преименуване 
на файлове 

3D граф редактора има 5 отделни страници от 
sheet1- sheet5. Всяка страница съдържа 
максимум 20 функции. Това значи, че можете 
да сортирате 100 функции в една 3D графика. 
Можете да изберете една от функциите и 
нейното изображение ще се покаже в граф 
прозореца. Фигурата може да се върти и 
разглежда от различни ъгли. 
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Както беше казано може да въвеждате функции от вида на z=f(x,y) или да 
въвеждате параметрични уравнения. 
 
 
 z=f(x,y)                Параметрични уравнения 
 

                             
 
 

 

    
 

 
 
 
Примерът по-долу е за функция z=xy, използвайки различни настройки в 3D 
Graph View Window. 
 
 

 

Можете да използвате 3D 
Graph View Window за да 
конфигурирате 
минимални и максимални 
стойности по х-, у-, z- 
координатите, както и s  и 
t променливите 
използвани при въвеждане 
на параметрични  
уравнения. 
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 xmin/ ymin= -3, xmax/ ymax=3           xmin/ ymin= -1, xmax/ ymax= -1     
 
 

                      
 
xgrid/ ygrid= 10                                           Initial default  
 
 
 
Използване на Trace за четене на 3D графики 
 
 
При натискане на бутона = на екрана веднага се появява курсова, чрез 
които се контролира пътя, които мишката/ курсора прави, като се появяват 
координатите на всяка избрана точка. 
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Изчисляването на стойностите по z- координатата при въвеждане на 
стойности по x и y става като се избере от главното меню Analysis → z- Cal. 
При което  се отваря следният диалогов прозорец: 
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Фиг. 4.3 
 

 
 
Фиг. 4.4   
 

 
 
 
Пример 1  
С примера по-долу е показано приближението на решението на следното диферен-
циалното уравнение dx/dt=x2/(t+1), x(0)=1, като е използван методът на Ойлер със 
стъпка h=0.10 и xb , която точка е получена при използването на стъпка h=s=0.05. 
изчислени са стойностите на xa(t) и xb(t) за t=0.1, 0.2, 0.3,...,1.0.  
Сравнени са получените стойности с точното решение x(t)  
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Точното решение на даденото диференциално уравнение е x=x(t)=1/(1-ln(t+1)) 
Цифровите решения и xb и техните грешки са показани на таблицата. 
По-надолу се вижда и формулите, чрез които е пресметнати всеки един ред 
 
За xa: 
 

 
 
За xb: вижда се, че за xb е използвана по-малак стъпка (s=0.05), стойностите на 
които са изчислени в последната графа 
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За точното решение: 
 

 
 
За изчисляването на всеки следващ ред се взима стойността от предходният: 
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|x-xa| показва грешката с което сме работили 
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Пример 2 
Задачата е решена с помощта на Рунге-Кута метода. Както вече бе споменато, 
методът е по-сложен за изпълнение, но е по-точен в сравнение с Ойлер метода.  
За пример е взето нелинейно диференциално уравнение  
4y’=x2+y2, y(0)=1. Стойностите за x1, x2 и x3 са съответно 0.8, 1.6, 2.4 (h = r = 0.8). 
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Както ясно се вижда за да се намери всяка една отделна точка е нужно първо да се 
намерят константите с1, с2, с3 и с4. Всяка една от тях се намира посредством 
формулите описани по-горе. 
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 -127-

 
 
За по-голяма точност и прецизност, същата задача може да се реши с използване на 
по малка стъпка ( не както тук h=0.8). 
 
Стойностите за х са през 0.05, като достигат до стойност 2.4: 
 
 

                     
 
 
След това всяка една от константите е изчислена последователно с различна 
стъпка, като се започне от стъпка 0.05 и се стигне то стъпка 0.8, така както е 
показано по долу. 
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За по-лесно въвеждане на данни и формули, извън SpreadSheet  приложението 
декларираме функцията с нейните променливи. Всеки път когато искаме да 
въвеждаме уравнението 4y’=x2+y2 е достатъчно само да изпишем f(x,y). В 
обозначената таблица по-горе е показано как са пресметнати с1, с2, с3 и с4 със 
стъпка 0.05 и 0.1, съответно s и  h. Вижда се, че за намиране на всяка е използвана 
формулата да декларираната предварително функция f(x,y). A2 и F2 са х и у. 
 

Когато работим с, тези стойности 
могат да се зададат в Main или 
eActivity и да бъдат използвани в 
SpreadSheet  приложението. 
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Всяка следваща стойност на константите се намира като се вземе стойността от 
предходният ред. 
 

                  
 
Стойностите на точките за изчислени посредством тези константи. 
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Същото е направено и за останалите стъпки p, r и m 
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5.  Създаване на програми  с  ClassPad 
 
ClassPad позволява създаването на програми тогава когато е необходимо да се 
изпълняват едни и същи изчисления многократно. Използва се  Program Appli-
cation. Приложението съдържа Program Editor за въвеждане на данни и Program 
Loader за зареждане на вече съществуващи програми. 
 

   
 
В следващото поле се оказват параметрите, ако такива има. И при всяко викане на 
програмата, ако такива за зададени, не трябва да се изпускат. 
 

     
 
Примерът за създаване на програма лежи върху основата на Рунге-Кута метода. 
Направена е програма, при която се въвеждат стъпките и точките от х1, …, хn, която 
програма пресмята цифровите решения на диференциалното уравнение  4y’=x2+y2. 
 

Program Loader се отваря 
автоматично при зареждане 
на приложението. 
Program Editor се използва 
за въвеждане на нови про-
грами  или за да се редакти-
рат съществуващи вече 
такива. С N се оказва вида на 
файла, които създаваме. Той 
може да е текстов (T), 
програмен (N) или  
дефинирана функция файл (F) 
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Програмен код: 
 
DelVar x,y 
seq(0,y,0,n-1,1)⇒Listy 
seq(0,c,0,n-1,1)⇒ListC1 
seq(0,c,0,n-1,1)⇒ListC2 
seq(0,c,0,n-1,1)⇒ListC3 
seq(0,c,0,n-1,1)⇒ListC4 
approx(seq(x,x,0,(n-1)*h,h))⇒Listx 
1⇒y 
1⇒Listy[1] 
For 2⇒k To n Step 1 
Listx[k-1]⇒x 
approx(h*f(x,y))⇒ListC1[k]:ListC1[k]⇒C1 
approx(h*f(x+h/2,y+C1/2))⇒ListC2[k]:ListC2[k]⇒C2 
approx(h*f(x+h/2,y+C2/2))⇒ListC3[k]:ListC3[k]⇒C3 
approx(h*f(x+h,y+C3))⇒ListC4[k] 
approx(y+(ListC1[k]+2*ListC2[k]+2*ListC3[k]+ListC4[k])/6)⇒y 
approx(y)⇒Listy[k] 
Next 
DispListEditor 
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Чрез създаване на програми бързо и лесно могат да се променят стойности, до 
получаването за задоволяващи резултати. 
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